
Škoda Scala Extra už

od 18 080 €

Cenové zvýhodnenie

až 3 000 €

Bohatá základná výbava

Extra

Cenník Škoda Scala Extra



Zvýhodnenie* 3 000 3 000
Akciová cena ** 18 080 19 590

Zvýhodnenie* 3 000 3 000
Akciová cena ** 19 170 20 680

Zvýhodnenie* 3 000 3 000
Akciová cena ** 21 260 22 770

Zvýhodnenie* - 3 000
Akciová cena ** - 22 180

Zvýhodnenie* - 3 000
Akciová cena ** - 24 290

Všetky informácie o aute
Modelová stránka

Vyskladajte si auto podľa seba
Online konfigurátor

* Akčný model Škoda Scala Extra nie je možné kombinovať s veľkoodberateľskými podmienkami. Bližšie informácie získate u participujúcich autorizovaných
partnerov značky Škoda.
** Najnižšie ceny príslušných motorových vozidiel za posledných 30 dní vám poskytujeme v zmysle zákona č. 108/2024 Z.z. o ochrane spotrebiteľa
a sú dostupné na internetovej stránke www.skoda.sk/ceny.

Scala Extra
Motor

.
Palivo

.
Prevodovka

.
Pohon

.
Cena (s DPH)

.
Extra

.
Extra Plus

.

1.0 TSI 70kW (95k)
.

Benzín
.

5° MP
.

predný
. Základná cena . 21 080 . 22 590 .

1.0 TSI 85kW (116k)
.

Benzín
.

6° MP
.

predný
. Základná cena . 22 170 . 23 680 .

1.0 TSI 85kW (116k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . 24 260 . 25 770 .

1.5 TSI 110kW (150k)
.

Benzín
.

6° MP
.

predný
. Základná cena . - . 25 180 .

1.5 TSI 110kW (150k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . - . 27 290 .
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Prečo práve Scala Extra?

Bezstarostne a bezpečne
Starosti s parkovaním hoďte pokojne za hlavu a parkujte ešte
jednoduchšie. Základná výbava akčného modelu prináša parkovacie
senzory (predné pre Extra Plus) a navyše aj parkovaciu kameru. V
čase neprítomnosti vaše auto postráži vstavaný alarm (pre Extra
Plus).

Komfort a štýl
Akčný model Extra ponúka množstvo praktických doplnkov –
tempomat, automatickú klimatizáciu, výškovo nastaviteľné predné
sedadlá s vyhrievaním a lakťovú opierku s JumboBoxom. Pasažieri na
zadných sedadlách určite ocenia viac súkromia vďaka Sunsetu.

Chcete ešte viac? Pridajte si Plus
Akčný model Extra Plus si extra užijete vďaka obľúbeným výbavovým
prvkom pre naozaj náročných zákazníkov – vyhrievaným volantom,
bezkľúčovému ovládaniu KESSY, voľbou jazdného režimu Drive
Mode Select či predĺženému sklu piatych dverí.

Teraz ešte výhodnejšie
Akčné modely Extra sú pre vás teraz k dispozícii ešte výhodnejšie – s
cenovým zvýhodnením až 3000 €. S rozpočtom vám navyše pomôže
značkové financovanie od Porsche Finance Slovakia s poistením
priamo v splátke.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Interiér Loft

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, EBV, MSR, ASR, EDS, HBA, DSR, ESBS, XDS+,
TPM, multikolíznej brzdy (MKB) a funkcie Prefill

Front Assist - výstraha pred kolíziou a podpora núdzového brzdenia
a Pedestrian Monitor (ochrana chodcov)

Easy Light Assist – svetelný senzor

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy

ISOFIX na sedadle spolujazdca

3. hlavová opierka vzadu

Easy Start – bezkľúčové štartovanie

Full LED predné svetlomety

Predné hmlové svetlá

Sivý strop

Disky Nyota z ľahkej zliatiny 6J × 16" – strieborné

Brzdy kotúčové (predné aj zadné)

Virtuálny kokpit 8"

Čítanie dopravných značiek

2-ramenný multifunkčný kožený volant

Tempomat

Infotainment Škoda s 8" displejom

8 reproduktorov

eCall, CareConnect na 3 roky

Bluetooth

Bezdrôtový Smartlink

2x USB-C vpredu + 2× USB vzadu (typ C len na nabíjanie)

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Výškovo nastaviteľné sedadlo vodiča a spolujazdca

Vyhrievanie predných sedadiel

Lakťová opierka s JumboBox

Zadné parkovacie senzory

Zadná parkovacia kamera

Vyhrievané dýzy ostrekovačov čelného skla

Ukazovateľ stavu kvapaliny v ostrekovači

Sunset

Elektricky ovládané a vyhrievané vonkajšie spätné zrkadlá

Vonkajšie spätné zrkadlá a kľučky dverí lakované vo farbe karosérie

Elektrické ovládanie okien vzadu

Asistent rozjazdu do kopca

Paket Simply Clever: háčiky na tašky – pevné, nesklopné, odkladacia
schránka – na strane za podbehom, uchytávacie klipy pre sieťový
program, sieťový program, 12V zásuvka v batožinovom priestore

Dáždnik

Sada na opravu pneumatík

Predĺžená záruka na 5 rokov/100 000 km (platí tá z podmienok, ktorá
nastane skôr, prvé 2 roky bez obmedzenia počtu kilometrov)

ŠKODA – Doživotná Garancia Mobility Premium - Poskytuje pomoc
servisným vozidlom na mieste poruchy (porucha na vozidle, chýbajúce
PHM, defekt pneumatiky, zabuchnuté/stratené kľúče, vybitá batéria,
zámena paliva), odtiahnutie vozidla, prípadne služby – náhradnú
dopravu, požičanie náhradného vozidla, ubytovanie pre posádku a i.

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Alarm

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Predĺžené sklo 5 dverí

2-ramenný kožený vyhrievaný multifunkčný volant (pre AP aj
podvolantovým ovládaním DSG)

Predné a zadné parkovacie senzory

Driving Mode Select

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá

Základná výbava

Extra

Extra Plus (navyše oproti Extra)
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Doplnková výbava

Light & View › Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča
(WYH platí iba pre Extra v kombinácii s WIS/WI2/PMA)

WIH/WYH 480 •

Light & View Plus › Naviac oproti Light&View
› Full LED Matrix predné svetlomety

(WYI platí iba pre Extra v kombinácii s WIS/WI2/PMA)

WII/WYI 1291 812

Adaptive Cruise Control - adaptívny tempomat do 210km/h PC5 490 490

Assisted Drive › Adaptive Cruise Control - adaptívny tempomat do 210km/h
› Adaptive Lane Assist

PIA 668 668

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné zrkadlá

s automatickým stmievaním na strane vodiča
(PYB platí iba v kombinácii s WIS/WI2/PMA)

PIB/PYB 1343 863

Safety › Crew Protect Assist – proaktívna ochrana cestujúcich
› Kolenný airbag vodiča
› Bočné airbagy vzadu

WIX 544 544

Deliaca sieťová stena 3CX 125 125

Medzipodlaha batožinového priestoru 3GD 181 181

Simply Clever Plus › Sieťový program
› Odkladací priestor pod prednými sedadlami
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(nie je možné s PWA/WQ7)

PIK 280 280

Simply Clever Plus (pre elektricky
ovládané sedadlo vodiča)

› Sieťový program
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(možné len s PWA/WQ7)

PI2 242 242

Príprava na ťažné zariadenie 1D7 216 216

Ťažné zariadenie – sklopné 1M6 1017 1017

Adaptér pre ťažné zariadenie ND1 40 40

Ostrekovače svetlometov 8X1 156 156

Interiér Lodge › Sedadlá Lodge
› Ambientné osvetlenie červené /biele
› Sivý poťah prístrojovej dosky
› Medené orámovanie výchudov ventilácie
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu

(iba s interiérom HP/HQ)

WQ3 449 449

Extra Extra PlusBezpečnosť

Extra Extra PlusFunkčnosť

Extra Extra PlusVolanty / interiéry / sedadlá
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Interiér Dynamic › Športové sedadlá
› Čierny strop
› 3-ramenný kožený športový multifunkčný volant (pre AP

s podovlantovým ovládaním DSG)
› Ambientné osvetlenie prepínateľné červené /biele
› Čierny poťah prístrojovej dosky
› Červené orámovanie výchudov ventilácie
› Ozdobné kryty pedálov z ušľachtilej ocele
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom AH)

WQ4 998 998

Interiér Suite › Poťah sedadiel Suedia /koža /umelá koža
› Čierny poťah prístrojovej dosky
› Chrómové orámovanie výchudov ventilácie
› Zadná ľakťová opierka
› Elektricky nastaviteľné sedadlo vodiča
› Ambientné osvetlenie prepínateľné červené /biele
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom JG/JI)

WQ7 1641 1641

Elektricky nastaviteľné sedadlo vodiča (možné len s WQ3/WQ4, nie je možné s PIK) PWA 501 501

2-ramenný kožený vyhrievaný multifunkčný volant PLE 109 •

3-ramenný kožený vyhrievaný športový multifunkčný volant PLM 248 139

2-ramenný kožený vyhrievaný multifunkčný volant pre DSG PLG 109 •

3-ramenný kožený vyhrievaný športový multifunkčný volant pre DSG PLP 248 139

Disky z ľahkej zliatiny Cortadero Aero 6J x 16" (205/55) P02 0 0

Disky z ľahkej zliatiny Nyota 6J x 16" (205/55) P06 • •

Disky z ľahkej zliatiny Montado Aero 6J x 16" – čierne (205/55) P08 144 144

Disky z ľahkej zliatiny Kajam 6,5J x 17" (205/50) - strieborné s čiernymi Aero krytmi PJG 604 604

Disky z ľahkej zliatiny Stratos 6,5J x 17" (205/50) PJP 564 564

Disky z ľahkej zliatiny Propus Aero 6,5J x 17" – čierne (205/50) PJR 708 708

Rezerva na oceľovom disku (neplnohodnotná), zdvihák, kľúč na kolesá PJA 170 170

Vyhrievané čelné sklo (možné len s PLG/PLP/PLE/PLM) (nie je možné s 4A4) WIE 151 151

Winter Premium & Technology
Plus

› Vyhrievané čelné sklo
› Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

PMA 354 354

Drive so Safe › Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Alarm
› Čierne lakované spätné zrkadlá a nárazník
› 10" Virtuálny kokpit
› Čierne lakované spätné zrkadlá a predná maska
› Sport Chassis Control–podvozok s nastaviteľnou tuhosťou tlmičov

(možné len s P08/PJV/PJR)
(nie je možné s PYC)

PKW 1113 692

Chrome paket › Podokenná chrómová lišta PIF 161 161

Image paket › Predĺžené sklo piatych dverí
› Spojler

PIU 235 •

Emotion paket › Naviac oproti Image:
› Panoramatická strecha
› Čierny strop

(bez schránky na okuliare)
(možné len s interiérmi HO/HQ/JI/AH)

WIV 1105 948

Extra Extra PlusVolanty / interiéry / sedadlá

Extra Extra PlusDisky / pneumatiky

Extra Extra PlusKomfort
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Vyhrievané zadné sedadlá (nie je možné s WIE a PMA) 4A4 193 193

Paket pre zlé cesty (zvýšený podvozok o 15 mm, dodatočná ochrana podvozka) PZP 156 156

Convenience so safe › Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Drive Mode Select
› Predné parkovacie senzory
› Alarm

WJM 715 •

Convenience Premium so safe › Naviac oproti Convenience so safe:
› Elektricky ovládané piate dvere s virtuálnym pedálom
› 10" Virtuálny kokpit
› Parkovací asistent

(PYC platí pre Extra Plus)

WJO/PYC 1567 950

Technology Plus › Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(WI2 platí pre Extra iba v kombinácii s PLG/PLP/PLE/PLM)
(PI6 platí pre Extra Plus)

WIS/WI2/PI6 203 203

Navi paket › 9.2" Škoda Navigation
› 10" Virtuálny kokpit
› Web Rádio
› Hlasové ovládanie
› Infotaiment Online na 3 roky

WIT 1285 1285

Sound paket › Sound System Škoda,
› Rezervné koleso (dojazdové)
› Zdvihák + klúč na kolesá

(možné len s WQ3/WQ4/WQ7 a naviac v kombinácii s 10"
Virtuálnym kokpitom možné len s WIT)

PJC 710 710

Alarm PD3 278 •

Black paket › Čierno-lakované spätné zrkadlá
› Čierna predná maska chladiča

(iba s P08/PJV a zároveň s PIU/WIV)

PMY 38 38

Modrá Energy UNI 0 0

Biela Candy SPE 406 406

Sivá Steel, Metalické farby MET 585 585

Červená Velvet FLT 1033 1033

Predĺžená záruka na 5 rokov/100 000km EA4 • •

Predĺžená záruka na 5 rokov/150 000km EA9 205 205

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Servis 5 rokov / 75 000 km 818 1556

Servis 5 rokov / 100 000 km 1046 2178

Servis 5 rokov / 150 000 km 1526 3438

Extra Extra PlusKomfort

Extra Extra PlusMultimédiá

Extra Extra PlusZabezpečenie vozidla

Extra Extra PlusOstatné

Basic ProfessionalServisné balíčky
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Ponuka farieb a diskov

Červená Velvet, metalická Modrá Race, metalická Biela Moon, metalická

Strieborná Smokey Diamond, metalická Čierna Magic, metalická Sivá Graphite, metalická

Modrá Energy, uni Biela Candy, uni Sivá Steel, uni

Propus Aero 17"
čierne

Stratos 17"
strieborné

Kajam 17"
strieborné

s aero krytmi

Montado Aero 16"
čierne

Nyota 16"
strieborné

Cortadero Aero 16"
strieborné

Oceľové disky 16"
s krytmi Tecton
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Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 20.10.2025 (MR2026)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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